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Getting Started
- AWARNNG

See the Important Safety and Product Information guide in the product box for product warnings and other
important information.

Install the camera memory card (Installing the Dash Camera Memory Card, page 2).
Update the maps and software on your device (Map and Software Updates, page 53).

Mount the device in your vehicle and connect it to power (Mounting and Powering the Garmin Device in Your
Vehicle, page 3).
Align the dash camera (Aligning the Camera, page 8).
+ Acquire GPS signals (Acquiring GPS Signals, page 5).
Adjust the volume (Adjusting the Volume, page 6) and display brightness (Adjusting the Screen Brightness,
page 6).
Set up a vehicle profile (Adding a Vehicle Profile, page 6).
Navigate to your destination (Starting a Route, page 26).

Garmin’ Device Overview

Microphone for Voice Command or hands-free calling

Power button

USB power and data port

Camera memory card slot

©@® @0 0

Map and data memory card slot
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Installing the Dash Camera Memory Card

Before the device can record video from the integrated dash camera, you must install a camera memory card.
The camera requires a microSD® memory card from 8 to 512 GB with a speed rating of Class 10 or higher.

You can use the included memory card, or you can purchase a compatible memory card from an electronics
supplier.

NOTE: A memory card is included so your device is ready to use out of the box. All memory cards have a limited
life and must be replaced periodically. Your device alerts you when the memory card has exceeded its useful life
and needs to be replaced. You can follow the troubleshooting tips to help extend the useful life of the memory
card (My memory card has degraded and needs to be replaced, page 58).

1 Insert a memory card (1) into the camera memory card slot (2).
NOTE: If you install the memory card into the incorrect slot, the camera cannot record video.

2 Press it in until it clicks.

Mounting Considerations
« Do not mount the device in a location that obscures the driver's view of the road.

It is your responsibility to ensure the mounting location complies with all applicable laws and ordinances, and
does not block your view of the road during the safe operation of your vehicle.

+ Choose a location that allows you to route the power cable safely.

When installing the device in a vehicle, install the device and power cable securely so they do not interfere with
the vehicle operating controls. Interference with the vehicle operating controls can result in a collision, which
could result in injury or death.

+ Choose a location that allows the device to clearly hear your voice.

You should avoid placing the device near a speaker or air vent, which can produce noise that interferes with
the microphones.

Choose a location that is within easy reach.
Choose a location that provides the dash cam with a clear view of the road.

You should verify the vehicle's windshield wipers clear the windshield area in front of the dash cam, and you
should avoid placing the dash cam behind a tinted area of the windshield.

Thoroughly clean the windshield before installing the mount.

N
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Mounting and Powering the Garmin Device in Your Vehicle

This product contains a lithium-ion battery. To prevent the possibility of personal injury or product damage
caused by battery exposure to extreme heat, store the device out of direct sunlight.

Before you use your device on battery power, you should charge it.
1 Press the suction cup to the windshield, and flip the lever (1) back toward the windshield.

A

2 Plug the vehicle power cable into the USB port (2) on the device.
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3 Plug the other end of the vehicle power cable 3) into a power outlet in your vehicle.

4 Fit the tab on the bottom of the mount into the slot @) on the back of the device, and press the device into
the mount until it clicks.

Turning the Device On or Off

- To turn the device on, press the power button (1), or connect the device to power.

+ To put the device in power saving mode, press the power button while the device is on.

While in power saving mode, the screen is off and the device uses very little power, but it can wake instantly
for use.

TIP: You can charge your device faster by putting it in power saving mode while charging the battery.
+ To turn off the device completely, hold the power button until a prompt appears on the screen, and select Off.

The prompt appears after five seconds. If you release the power button before the prompt appears, the
device enters power saving mode.
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Acquiring GPS Signals

When you turn on your navigation device, the GPS receiver must collect satellite data and establish the current
location. The time required to acquire satellite signals varies based on several factors, including how far you are
from the location where you last used your navigation device, whether you have a clear view of the sky, and how
long it has been since you last used your navigation device. The first time you turn on your navigation device, it
may take several minutes to acquire satellite signals.

1 Turn on the device.
2 Wait while the device locates satellites.
3 If necessary, go to an open area, away from tall buildings and trees.

.1l in the status bar indicates the satellite signal strength. When at least half the bars are filled, the device is
ready for navigation.

Status Bar Icons

The status bar is located at the top of the main menu. The status bar icons display information about features
on the device. You can select some icons to change settings or view additional information.

I GPS signal status. Hold to view GPS accuracy and acquired satellite information (Viewing GPS
anll Signal Status, page 60).

Bluetooth® technology status. Select to view the Bluetooth settings (Wireless Network Settings,
page 49).

Wi-Fi® signal strength. Select to change the Wi-Fi settings (Wireless Network Settings, page 49).

Connected to hands-free calling. Select to place a phone call (Hands-Free Calling, page 39).

E ) *

Active vehicle profile. Select to view the vehicle profile settings (Editing a Vehicle Profile, page 7).
10 Current time. Select to set the time (Setting the Time, page 51).

Battery charge level.

& 09

Garmin Drive” app connection status (Pairing with Your Smartphone, page 36).

?; Temperature. Select to view the weather forecast (Viewing the Weather Forecast, page 41).

 Jivt

Dash cam recording status. Select to open the dash cam controls.

Using the On-Screen Buttons

On-screen buttons allow you to navigate the pages, menus, and menu options on your device.
- Select € to return to the previous menu screen.

- Hold € to quickly return to the main menu.

+ Select A\ or W to scroll through lists or menus.

+ Hold &\ or W to scroll faster.

. Select = to see a context-based menu of options for the current screen.
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Adjusting the Volume
1 Select ‘))
2 Select an option:
+ Use the slider bar to adjust the volume.
- Select §) to mute the device.
+ Select a check box to enable or disable additional sound options.

Using the Audio Mixer

You can use the audio mixer to set the volume levels for different audio types, such as navigation prompts or
phone calls. The level for each audio type is a percentage of the master volume.

1 Select ‘))
2 Select Mixer.
3 Use the sliders to adjust the volume for each audio type.

Adjusting the Screen Brightness
1 Select £¥ > Display > Brightness.
2 Use the slider bar to adjust the brightness.

Vehicle Profiles

Entering your vehicle profile characteristics does not guarantee that your vehicle's characteristics will be
accounted for in all route suggestions or that you will receive the warning icons in all cases. Limitations may
exist in the map data such that your device cannot account for these restrictions or road conditions in all cases.
Always defer to all posted road signs and road conditions when making driving decisions.

Routing and navigation are calculated differently based on your vehicle profile. The activated vehicle profile
is indicated by an icon in the status bar. The navigation and map settings on your device can be customized
separately for each vehicle type.

When you activate a camper vehicle profile, the device avoids including restricted or impassable areas in routes
based on the dimensions, weight, and other characteristics you entered for your vehicle.

Adding a Vehicle Profile
You should add a vehicle profile for each camper to be used with your device.
1 From the status bar, select the vehicle profile icon, such as il or iRy.
2 Select +
3 Select your vehicle type:
+ To add a motorhome with a permanently attached camper, select Motorhome.
+ To add a motorhome pulling a trailer, select Motorhome with Trailer.
+ To add a camper pulled behind a passenger vehicle, select Vehicle With Trailer.
4 If necessary, select your trailer type:
+ To add a camper pulled using a standard hitch, select Travel Trailer.
+ To add a camper pulled using a fifth-wheel hitch, select Fifth Wheel.
NOTE: This trailer type is not available in all areas.
+ To add a boat trailer pulled using a standard hitch, select Boat Trailer.
+ To add a trailer pulled using a standard hitch, select Trailer.
5 Follow the on-screen instructions to enter the vehicle characteristics.

After you add a vehicle profile, you can edit the profile to enter additional detailed information (Editing a Vehicle
Profile, page 7).
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Adding an Environmental Zone Vehicle Profile

You can add a vehicle profile for the environmental zone settings specific to your vehicle, such as fuel type and
emission standard.

NOTE: This feature is not available for all regions or product models.
1 Select £¥ > Navigation > Environmental Zones.
2 Follow the on-screen instructions.

Car Profile

The car profile is a preloaded vehicle profile intended for use in an automobile without a trailer. While using
the car profile, the device calculates standard automobile routes, and routing for large vehicles is not available.
Some features and settings specific to large vehicles are not available while using the car profile.

Switching the Vehicle Profile
You can manually switch to another vehicle profile at any time.
1 From the status bar, select the vehicle profile icon, such as i or SiRy.
2 Select a vehicle profile.

The vehicle profile information appears, including measurements and weight.
3 Select Select.

Editing a Vehicle Profile

You can change basic vehicle profile information or add detailed information to a vehicle profile, such as
maximum speed.

1 Select £ > Vehicle Profile.

2 Select a vehicle profile to edit.

3 Select an option:
To edit the vehicle profile information, select ‘\ and select a field to edit.
To rename the vehicle profile, select W > = > Rename Profile.
To delete the vehicle profile, select ‘\ > = > Delete.

Adding Propane Tanks
NOTE: This feature is not available on all product models.

When you add your propane tanks to your vehicle profile, the device avoids routing through areas with propane
tank restrictions that may affect your route. The device also alerts you when you approach areas that require
you to shut off your propane tanks.

1 From the vehicle profile, select © > Add Tank.
2 Enter the weight of the propane tank, and select OK.

Vehicle Profiles



Dash Cam
Aligning the Camera

Do not attempt to align the camera while driving because doing so can cause distraction that could lead to an
accident resulting in serious personal injury or death.

Advanced driver assistance features may not perform properly if the camera is not aligned. You should align the
dash camera each time you mount or reposition the device.

1 Select 'Q' > Dash Cam > Camera Placement.

Select Horizontal Placement, and select the horizontal location of your device on the windshield.
Select Vehicle Height, and select your vehicle type.

Select Alignment.

Tilt the device and turn the camera left or right to align the camera.

The camera should point straight ahead, and the horizon should be centered between the top and bottom of
the screen.

a b WwN

Dash Cam Recording

Some jurisdictions may prohibit or regulate recording audio and video, or taking photographs. Jurisdictions
may require that all parties have knowledge of the recording and provide consent before you record audio and
video or take photographs. It is your responsibility to know and comply with all laws, regulations, and any other
restrictions in your jurisdiction.

The dash cam records video to the camera memory card (Installing the Dash Camera Memory Card, page 2).

By default, the device immediately starts recording video when it turns on, and it continues recording until it is
turned off. If the memory card is full, the device automatically deletes the oldest unsaved video to create space
for new video.

When the option to promptly delete unsaved video is enabled, the device continually deletes unsaved video
more than three minutes old and deletes all unsaved video each time it is powered off. You can enable or
disable this feature in the camera settings (Dash Cam Settings, page 50).

You can save a video recording to prevent it from being overwritten or deleted.

Saving a Dash Cam Recording

You can save a portion of the recorded video to prevent it from being overwritten by new video. By default, the
device uses a sensor to detect possible accidental collisions and saves video footage before, during, and after
the detected event. You can also manually save video at any time.

1 While the dash cam is recording, select Dash Cam > B

The device saves the video footage before, during, and after you select =
2 Select again to extend the saved recording time (optional).

A message indicates the video is saving.

The memory card has limited storage. After you save a video recording, you should transfer the recording to
your computer or other external storage location for permanent storage (Videos on Your Computer, page 9).

(o)
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Stopping or Starting Dash Camera Recording
1 Select Dash Cam.
2 Select an option:

+ To stop recording, select B

TIP: By default, recording starts automatically the next time you turn on the device. You can disable this
option in the camera settings (Dash Cam Settings, page 50).

+ To start recording, select ‘

Turning Audio Recording On or Off

Some jurisdictions may prohibit recording audio in the vehicle or may require that all passengers have
knowledge of the recording and provide consent before you record audio in the vehicle. It is your responsibility
to know and follow all laws and restrictions for your jurisdiction.

The device can record audio using the integrated microphone while recording video. You can turn audio
recording on or off at any time.

Select £F > Dash Cam > Record Audio.

Viewing Videos and Photos

NOTE: The device stops recording video while you view videos or photos.
1 Select Gallery > Yes.

2 Select a video or photo.

The device displays the video or photo. Videos start playing automatically. If the video or photo includes
location information, a map shows the location.

Videos on Your Computer

Media is stored in the DCIM folder on the camera memory card. Videos are stored in MP4 file format.Photos are
stored in JPG format. You can view and transfer media by connecting the memory card or the device to your
computer (Connecting the Device to Your Computer, page 59).

The media is sorted into several folders.

100EVENT: Contains videos saved automatically when the device detected an incident.
101PHOTO: Contains photos.

102SAVED: Contains videos saved manually by the user.

105UNSVD: Contains unsaved video footage. The device overwrites the oldest unsaved video when the storage
space for unsaved video is full.

Deleting a Video or Photo
1 Select Gallery > Yes.

2 Select a video or photo.

3 Select ﬁ > Yes.

Vault Storage
NOTE: This feature is not available for all countries.

You can upload, manage, and share dash camera footage on a secure, online storage drive using the Vault. The
dash camera uploads saved videos to the Vault automatically while it is connected to a Wi-Fi network.

You can store videos in the Vault for up to 24 hours with your Garmin Drive account. There is no size limit to the
amount of data you can store. You can purchase an optional Vault subscription from the Garmin Drive app on
your smartphone to extend your storage time.

NOTE: Your dash camera must be connected to a Wi-Fi network to use this feature.
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Upgrading Your Vault Subscription

You can purchase an optional Vault subscription to extend your storage time.

1 From the Garmin Drive app on your smartphone, select £+ > Vault Access > Need More Time?.
2 Follow the on-screen instructions.

Sharing a Video

You can share a secure link to a dash camera video from the Vault.
1 From the Garmin Drive app on your smartphone, select Vault.

2 Select a video, and select Secure Share.

3 Follow the on-screen instructions.

Editing and Exporting a Video
You can trim the length of your video to remove unnecessary footage before exporting it to the Vault.
NOTE: Videos stored in the Vault cannot be trimmed.

1 While viewing a video, drag the trimming handles @ on the video progress bar left or right to trim the video
length.

2 Select the Include Audio check box to include the recorded audio (optional).
3 Select D or select Export.

NOTE: You must keep the app in the foreground while exporting a video.

The app exports the trimmed video to the Vault and saves the video to your smartphone.
4 After the video export is complete, select an option (optional):

+ To remove the video from the camera memory card, select Remove From Camera.

+ Toreturn to the gallery, select > or select Done.

Disabling a Shared Video Link

You can disable a link to a video that you previously shared from the Vault. When you disable a shared video
link, the video is set to private and the shared link and passcode are disabled.

1 From the Garmin Drive app on your smartphone, select Vault.
2 Select a video, and select Disable Link > Continue.

Removing a Video from the Vault
1 From the Garmin Drive app on your smartphone, select Vault.
2 Select a video, and select Remove From Vault > Continue.
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Voice-Activated Features
- AwARNN¢

The Garmin device uses natural language processing to understand the intent of your spoken requests. You
can ask questions or speak commands in natural language, using complete sentences. Many example phrases
are provided in the manual, but you can experiment with speaking to the device using the language most
comfortable to you.

Garmin voice-activated navigation allows you to search for locations and addresses, start routes with turn-by-
turn directions, place hands-free phone calls, and more. You can launch Garmin voice-activated navigation by
saying OK, Garmin followed by a request.

NOTE: This feature is not available for all product models or languages.

Voice Command Tips

+ Speak in a normal voice directed at the device.

+ Reduce background noise, such as voices, or the radio, to increase the accuracy of the voice recognition.
+ Respond to prompts from the device as needed.

Launching Garmin Voice-Activated Navigation

Garmin voice-activated navigation allows you to use plain language spoken requests to search for locations and
addresses, start routes with turn-by-turn directions, place hands-free phone calls, and more.

« Say OK, Garmin, and make a spoken request.
For example, you can say phrases like these:
> OK, Garmin, take me home.
> OK, Garmin, where's the library?

Starting a Route

Going to a Saved Location Using Your Voice

It is useful to start a route on your Garmin device each time you travel to a saved location, even though you may
already know how to get there. Your device can help you avoid reported traffic delays and construction that may
affect your route.

You can say phrases like these to start a route to your saved locations (Saving Locations, page 24).
+ OK, Garmin, take me home.

+ OK, Garmin, take me to work.

+ OK, Garmin, start a route to school.

Going to an Address Using Your Voice

You can say phrases like these to start a route to a nearby address, or to an address in a specific city.
+ OK, Garmin, take me to One Garmin Way.

+ OK, Garmin, start a route to twelve hundred East 157st Street in Olathe, Kansas.
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Going to a Business or Named Location Using Your Voice
You can say phrases like these to find and navigate to a business or location by name or category.
Nearby locations
« OK, Garmin, find a coffee shop.
* OK, Garmin, where's the library?
* OK, Garmin, take me to Starbucks.
Locations near a different city
« OK, Garmin, find Mexican food near Denver, Colorado.
+ 0K, Garmin, find The Field Museum near Chicago, lllinois.
* OK, Garmin, find Casa Bonita near Denver, Colorado.
Locations near an intersection
« OK, Garmin, find barbecue near 12th Street and Vine Street.
+ OK, Garmin, find Arthur Bryant’s Barbecue near 12th Street and Vine Street.

Going to a City or Intersection Using Your Voice

You can say phrases like these to find and navigate to a city or intersection.
+ OK, Garmin, find Chandler, Arizona.

« OK, Garmin, find Michigan Avenue and Erie Street.

Checking Your Arrival Time
While a route is active, you can say a phrase to check your estimated time of arrival at your destination.
Say OK, Garmin, what time will we arrive?.

Stopping a Route Using Your Voice

You can say phrases like these to stop navigating a route.
+ OK, Garmin, stop the route.

* OK, Garmin, stop navigating.

Controlling the Camera Using Voice Commands
1 Say OK Garmin to activate the voice control feature.

The camera plays a tone and starts listening for a command.
2 Say a command:

+ To save a video, say Save Video.

+ To take a picture, say Take a Picture.

The camera plays a tone when it recognizes your command.

Placing a Phone Call Using Your Voice

You can use a voice command to call to a contact from the phone book of your paired smartphone.
Say OK, Garmin, call, and say the contact name.
For example, you can say OK, Garmin, call Mom..

Changing Device Settings Using Your Voice

You can say phrases like these to set device settings to a value from 0 to 10.
+ OK, Garmin, increase the volume.

* OK, Garmin, set the volume to 0.

+ OK, Garmin, set the volume to 9.

+ 0K, Garmin, decrease the brightness.

+ OK, Garmin, set the brightness to 5.
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Driver Awareness Features and Alerts

/\ CAUTION

The driver alerts and speed limit features are for information only and do not replace your responsibility to abide
by all posted speed limit signs and to use safe driving judgment at all times. Garmin is not responsible for any
traffic fines or citations you receive for failing to follow all applicable traffic laws and signs.

Your device provides features that can help encourage safer driving and increase efficiency, even when you are
driving in a familiar area. The device plays an audible tone or message and displays information for each alert.
You can enable or disable the audible tone for some types of driver alerts. Not all alerts are available in all areas.

Schools: The device plays a tone and displays the speed limit (if available) for an upcoming school or school
zone.

Speed limit exceeded: The device displays a red border on the speed limit icon when you exceed the posted
speed limit for the current road.

Speed limit reduced: The device plays a tone and displays the upcoming speed limit so you can be prepared to
adjust your speed.

Wrong way on a one-way street: The device plays a message and displays a full-screen warning if you travel the
wrong way on a one-way street. The edges of the screen appear red and an alert remains at the top of the
screen until you leave the one-way street or correct your direction of travel.

Railroad crossing: The device plays a tone to indicate an upcoming railroad crossing.
Animal crossing: The device plays a tone to indicate an upcoming animal crossing area.
Curves: The device plays a tone to indicate a bend in the road.

Slower traffic: The device plays a tone to indicate slower traffic when you approach slower traffic at a higher
speed. Your device must be receiving traffic information to use this feature (Traffic, page 41).

Construction zone: The device plays a tone and displays a message when you approach a construction zone.
Lane closure: The device plays a tone and displays a message when you approach a lane closure.

Break planning: The device plays a tone and suggests upcoming rest stops after you have been driving for a
long time.

Risk of grounding: The device plays a tone and displays a message when you approach a road where your
vehicle could become grounded.

Lateral wind: The device plays a tone and displays a message when you approach a road where there is risk of
lateral wind.

Narrow road: The device plays a tone and displays a message when you approach a road that may be too
narrow for your vehicle.

Steep hill: The device plays a tone and displays a message when you approach a steep hill.

State and country borders: The device plays a tone and displays a message when you approach the border of a
state or country.

Shut off propane: The device plays a tone and displays a message when you approach an area where propane
should be turned off.

Forward collision warning: The device alerts you when it detects that you are not maintaining a safe distance
between your vehicle and the vehicle in front of you.

Lane departure warning: The device alerts you when it detects you may be crossing a lane boundary
unintentionally.

Enabling or Disabling Driver Alerts

You can enable or disable several types of driver alerts.
1 Select 'Q' > Driver Assistance > Driver Alerts.

2 Select or clear the check box next to each alert.
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Red Light and Speed Cameras

Garmin is not responsible for the accuracy of or the consequences of using a red light or speed camera
database.

NOTE: This feature is not available for all regions or product models.

Information about red light and speed camera locations is available in some areas for some product models.
The device alerts you when you approach a reported speed or red light camera.

In some areas, your device can receive red light and speed camera data while connected to a smartphone
running the Garmin Drive app.

You can use the Garmin Express” software (garmin.com/express) to update the camera database stored on
your device. You should update your device frequently to receive the most up-to-date camera information.

Advanced Driver Assistance System

Your device includes an advanced driver assistance system (ADAS), which uses the integrated dash camera to
provide warnings and alerts about your driving environment.

You can enable or disable each of the advanced driver assistance features in the Driver Assistance settings
(Driver Assistance Settings, page 49).

Forward Collision Warning System

The forward collision warning system (FCWS) feature is for information only and does not replace your
responsibility to observe all road and driving conditions, abide by all traffic regulations, and use safe driving
judgment at all times. The FCWS relies on the camera to provide a warning of upcoming vehicles and, as

a result, may have limited functionality in low visibility conditions. For more information, go to garmin.com
/warnings.

The FCWS feature alerts you when the device detects that there is not a safe distance between your vehicle
and the vehicle in front of you. The device determines your vehicle speed using GPS, and it calculates an
estimated safe following distance based on your speed. The FCWS activates automatically when your vehicle
speed exceeds 65 km/hr (40 mph).

When the device detects that you are too close to the vehicle in front of you, the device plays an audible alert,
and a warning appears on the screen.

E_ Forward Collision Warning

Forward Collision Warning System Performance Tips

Several factors affect the performance of the forward collision warning system (FCWS). Some conditions may
prevent the FCWS feature from detecting a vehicle in front of you.

The FCWS feature activates only when your vehicle speed exceeds 65 km/h (40 mph).

The FCWS feature may not detect a vehicle in front of you when the camera's view of the vehicle is obscured
by rain, fog, snow, sun or headlight glare, or darkness.

The FCWS feature may not function properly if the camera is incorrectly aligned (Aligning the Camera,

page 8).

The FCWS feature may not detect vehicles farther away than 40 m (130 ft.) or closer than 5 m (16 ft.).

The FCWS feature may not function properly if the camera placement settings do not correctly indicate your
vehicle height or the placement of your device in the vehicle (Aligning the Camera, page 8).
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Lane Departure Warning System

The lane departure warning system (LDWS) feature is for information only and does not replace your
responsibility to observe all road and driving conditions, abide by all traffic regulations, and use safe driving
judgment at all times. The LDWS relies on the camera to provide warnings for lane markers and, as a result, may
have limited functionality in low visibility conditions. For more information, go to garmin.com/warnings.

The LDWS feature alerts you when the device detects you may be crossing a lane boundary unintentionally.

For example, the device alerts you if you cross some solid-painted lane boundaries. The LDWS feature provides
alerts only when your vehicle speed exceeds 65 km/h (40 mph). The alert appears on the left or right side of the
screen to indicate which lane boundary you crossed.

el |8

NOTE: For the best LDWS performance, you should set the Camera Placement option to indicate the location of
the device in your vehicle.

Setting the Camera Placement

You can mount the device in the left, center, or right of your windshield or dash. For the best LDWS performance,
you should set the Camera Placement option to indicate the location of your device in the vehicle.

1 Select 'ﬁ' > Dash Cam > Camera Placement > Horizontal Placement.
2 Select the location of the device.
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Lane Departure Warning Performance Tips

Several factors affect the performance of the lane departure warning system (LDWS). Some conditions may
prevent the LDWS feature from detecting lane departures.

The LDWS feature provides alerts only when your vehicle speed exceeds 65 km/h (40 mph).

The LDWS feature does not provide alerts on certain types of roads, such as highway ramps or merging
lanes.

The LDWS feature may not function properly if the camera is incorrectly aligned.

The LDWS feature may not function properly if the camera placement settings do not correctly indicate your
vehicle height or the placement of your device in the vehicle (Aligning the Camera, page 8).

The LDWS feature requires a clear, continuous view of the lane divider lines.

- Lane departures may not be detected when divider lines are obscured by rain, fog, snow, extreme
shadows, sun or headlight glare, road construction, or any other visual obstruction.

> Lane departures may not be detected if lane divider lines are misaligned, missing, or heavily worn.
The LDWS feature may not detect lane departures on extremely wide, narrow, or winding roads.

Warning and Alert Symbols

Entering your vehicle profile characteristics does not guarantee that your vehicle's characteristics will be
accounted for in all route suggestions or that you will receive the warning icons in all cases. Limitations may
exist in the map data such that your device cannot account for these restrictions or road conditions in all cases.
Always defer to all posted road signs and road conditions when making driving decisions.

Warning and alert symbols may appear on the map or in route directions to alert you to potential hazards and
road conditions.

16
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Restriction Warnings
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AIB Weigh station

- Road not verified for motorhomes

Finding and Saving Locations

The maps loaded in your device contain locations, such as restaurants, hotels, auto services, and detailed street
information. The Where To? menu helps you find your destination by providing several methods to browse,
search, and save this information.

From the main menu, select Where To?.

+ To quickly search all locations on your device, select Q search (Finding a Location Using the Search Bar,
page 18).
+ To find an address, select Address (Finding an Address, page 19).

+ To browse or search pre-loaded points of interest by category, select Categories (Finding a Location by
Category, page 20).

+ To search near a different city or area, select @ next to the current search area (Changing the Search Area,
page 20).

- To view and edit your saved locations, select Saved (Saving Locations, page 24).

+ To view locations you have recently selected from the search results, select Recent (Viewing Recently Found
Locations, page 23).

+ To search for RV parks and campgrounds, select Campgrounds (Finding Campgrounds, page 21).
+ To browse and search Tripadvisor® traveler ratings, select Tripadvisor (Tripadvisor, page 22).

+ To navigate to specific geographic coordinates, select Coordinates (Finding a Location Using Coordinates,
page 23).

Finding a Location Using the Search Bar
You can use the search bar to search for locations by entering a category, brand name, address, or city name.
1 Select Where To?.
2 Select Search in the search bar.
3 Enter all or part of the search term.
Suggested search terms appear below the search bar.
4 Select an option:
- To search for a type of business, enter a category name (for example, "movie theaters").
+ To search for a business name, enter all or part of the name.
+ To search for an address near you, enter the house number and street name.
+ To search for an address in another city, enter the house number, street name, city, and state.
+ To search for a city, enter the city and state.
+ To search for coordinates, enter latitude and longitude coordinates.
5 Select an option:
+ To search using a suggested search term, select the term.
- To search using the text you entered, select Q.
6 If necessary, select a location.
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Trendy Places

NOTICE

Garmin is not responsible for the accuracy or timeliness of the Tripadvisor or Michelin® information. You are
responsible for understanding and complying with any applicable rules, laws, or regulations associated with
points of interest.

The Trendy Places search feature includes both Tripadvisor and Michelin points of interest and ratings,
providing a comprehensive list of attractions. You can filter the search results by categories, ratings, and
distance from the route.

NOTE: Tripadvisor and Michelin points of interest are not available in all areas.

Performing a Trendy Places Search

1 Select Trendy Places.

2 Select Search Filters to filter the displayed points of interest by category or rating (optional).
3 Select Q, and enter a search term (optional).

Finding an Address

NOTE: The order of the steps may change depending on the map data loaded on your device.
1 Select Where To?.

If necessary, select 9 to search near a different city or area.

Select Address.

Follow the on-screen instructions to enter address information.

Select the address.
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Location Search Results

The location search results appear in a list, with the nearest location at the top. Each numbered location also
appears on the map. You can scroll down to view more results.
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@ Bl A Select to use the Plan Arrival tool.

@ 0 Select to view detailed information about the location.

@9 Select to create a route to the location using the feature (Starting a Route Using the Road Trip
‘g Routes Feature, page 26).

@ Gol Select to start navigating to the location using the recommended route.

Changing the Search Area

By default, the device searches for locations near your current location. You can also search other areas, such
as near your destination, near another city, or along your active route.

1 Select Where To?.
2 Select @ next to the current search area Q.

I Search |

Trendy Places

Campgrounds
Categories

u Saved

3 Select a search area.
4 If necessary, follow the on-screen instructions to select a specific location.

The selected search area appears next to 9. When you search for a location using any of the options in the
Where To? menu, the device suggests locations near this area first.

Points of Interest

NOTICE

You are responsible for understanding and complying with any applicable rules, laws, or regulations associated
with points of interest.

A point of interest is a place that you may find useful or interesting. Points of interest are organized by category
and can include popular travel destinations such as gas stations, restaurants, hotels, and entertainment venues.

Finding a Location by Category

1 Select Where To?.

2 Select a category, or select Categories.
3 If necessary, select a subcategory.

4 Select a location.
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Searching Within a Category

After you have performed a search for a point of interest, certain categories may display a Quick Search list that
shows the last four destinations you selected.

1 Select Where To? > Categories.
2 Select a category.
3 Select an option:
+ Select a destination from the quick search list on the right side of the screen.
The quick search list provides a list of recently found locations in the selected category.
+ Select a subcategory, if necessary, and select a destination.

Finding Campgrounds

NOTICE

You are responsible for understanding and complying with any applicable rules, laws, or regulations associated
with campgrounds.

Select Where To? > Campgrounds.

Finding RV Parks

NOTE: This feature is not available in all areas.
Select Where To? > PlanRV™ Parks.

Finding RV Services

NOTE: This feature is not available in all areas.

You can find nearby locations that offer repair, towing, and other services for RVs.
Select Where To? > PlanRV™ Services.

Finding National Parks

Device models that include maps for North America or the United States also include detailed information for
national parks in the United States. You can navigate to a national park or to a location within a national park.

NOTICE

You are responsible for understanding and complying with any applicable rules, laws, or regulations associated
with national parks.

1 Select Where To? > National Parks.

A list of national parks appears, with the nearest park at the top.
2 Select Search, and enter all or part of the park name to narrow the results (optional).
3 Select a national park.

A list of categories for locations of features and amenities within the park appears below the park name.
4 Select an option:

+ To start navigating to the park, select Go!.

To view more park information or explore the park features and amenities, select ([ )

+ To quickly find a location within the park, select a category from the list below the park name, and select a
location.
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Exploring National Park Features and Amenities

On North American product models, you can explore detailed information about the features and amenities
available inside a national park, and navigate to specific locations in the park. For example, you can find
campgrounds, landmarks, visitor centers, and popular attractions.

1 From the location search results, select a national park.

A list of categories for park features and amenities appears.
2 Select a category.
3 Select a location, and select Go!.

Foursquare’

NOTICE

Garmin is not responsible for the accuracy or timeliness of information provided by Foursquare.

You are responsible for understanding and complying with any applicable rules, laws, or regulations associated
with points of interest.

Foursquare is a location-based social network. Your device includes millions of pre-loaded Foursquare points of
interest, which are indicated by the Foursquare logo in your location search results.
Searching Foursquare Points of Interest
You can search for Foursquare points of interest loaded on your device.
Select Where To? > Foursquare®.

Viewing Foursquare Location Details

You can view Foursquare location information and user ratings.

1 From the location search results, select a Foursquare point of interest.
2 Select o

Tripadvisor

NOTICE

Garmin is not responsible for the accuracy or timeliness of the Tripadvisor information.

You are responsible for understanding and complying with any applicable rules, laws, or regulations associated
with points of interest.

Your device includes Tripadvisor traveler ratings. Tripadvisor ratings appear automatically in the search results
list for restaurants, hotels, and attractions. You can also search for nearby Tripadvisor points of interest and
sort by distance or popularity.
Finding Tripadvisor Points of Interest
1 Select Where To? > Tripadvisor.
2 Select a category.
3 If necessary, select a subcategory.
A list of nearby Tripadvisor points of interest for the category appears.
4 Select Sort Results to filter the displayed points of interest by distance or popularity (optional).
5 Select Q, and enter a search term (optional).
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Navigating to Points of Interest Within a Venue
NOTE: This feature may not be available in all areas or for all product models.

You can create a route to a point of interest (POI) within a larger venue, such as a store in a shopping mall or a
specific terminal in an airport.

1 Select Where To? > Search.
2 Enter the name of the venue, and select Q.
3 Select the venue.
A list of categories for POls within the venue appears.
4 Select a category, select a location, and select Gol.
The device creates a route to the parking area or venue entrance closest to the POI. When you arrive at the
destination, a checkered flag indicates the recommended parking area. A labeled point indicates the location of
the POI within the venue.
Exploring a Venue
NOTE: This feature may not be available in all areas or for all product models.
You can view a list of all points of interest located within each venue.
1 Select a venue.
2 Select @ > Explore this Venue.

Search Tools
Search tools allow you to search for specific types of locations by responding to on-screen prompts.

Finding an Intersection

You can search for an intersection or junction between two streets, highways, or other roads.
1 Select Where To? > Intersections.

2 Follow the on-screen instructions to enter street information.

3 Select the intersection.

Finding a Location Using Coordinates

You can find a location using latitude and longitude coordinates.

1 Select Where To? > Coordinates.

If necessary, select R, and change the coordinate format or datum.
Select Coordinates.

Enter the latitude and longitude coordinates, and select Done.
Select an option:

+ To save the coordinates as a location, select Save.

+ To start a route to the coordinates, select Gol.
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Viewing Recently Found Locations
Your device stores a history of the last 50 locations you have found.
Select Where To? > Recent.

Clearing the List of Recently Found Locations
Select Where To? > Recent > = > Clear > Yes.

Viewing Current Location Information

You can use the Where Am 1? page to view information about your current location. This feature is helpful if you
need to tell emergency personnel your location.

From the map, select the vehicle.
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Finding Emergency Services and Fuel
You can use the Where Am 1? page to find the nearest hospitals, police stations, and fuel stations.
1 From the map, select the vehicle.
2 Select Hospitals, Police Stations, or Fuel.
A list of locations for the selected service appears, with the nearest locations at the top.
3 Select a location.
4 Select an option:
+ To navigate to the location, select Go!
- To view the phone number and other location details, select @).

Getting Directions to Your Current Location

If you need to tell another person how to get to your current location, your device can give you a list of
directions.

1 From the map, select the vehicle.
2 Select = > Directions to Me.

3 Select a starting location.

4 Select Select.

Adding a Shortcut

You can add shortcuts to the Where To? menu. A shortcut can point to a location, a category, or a search tool.
The Where To? menu can contain up to 36 shortcut icons.

1 Select Where To? > Add Shortcut.

2 Select an item.

Removing a Shortcut

1 Select Where To? > = > Remove Shortcut(s).
2 Select a shortcut to remove.

3 Select the shortcut again to confirm.

4 Select Done.

Saving Locations

Saving a Location

1 Search for a location (Finding a Location by Category, page 20).
From the search results, select a location.

Select 0 > Save.

If necessary, enter a name, and select Done.

Select Save.
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Saving Your Current Location

1 From the map, select the vehicle icon.
2 Select OK.

3 Enter a name, and select Done.
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Editing a Saved Location

Select Where To? > Saved.

If necessary, select a category.

Select a location.

Select 0

Select = > Edit.

Select an option:

+ Select Name.

+ Select Phone Number.

+ Select Categories to assign categories to the saved location.
+ Select Change Map Symbol to change the symbol used to mark the saved location on a map.
7 Edit the information.

8 Select Done.
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Assigning Categories to a Saved Location

You can add custom categories to organize your saved locations.

NOTE: Categories appear in the saved locations menu after you have saved at least 12 locations.
Select Where To? > Saved.

Select a location.

Select o

Select = > Edit > Categories.

Enter one or more category names, separated by commas.

If necessary, select a suggested category.

Select Done.
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Deleting a Saved Location

NOTE: Deleted locations cannot be recovered.

1 Select Where To? > Saved.

2 Select = > Delete.

3 Select the box next to the saved locations to delete, and select Delete > Yes.

Following a Route

Routes
A route is a path from your current location to one or more destinations.

+ The device calculates a recommended route to your destination based on the preferences you set, including
the route calculation mode (Changing the Route Calculation Mode, page 27) and avoidances (Avoiding
Delays, Tolls, and Areas, page 30).

+ The device can automatically avoid roads that are not appropriate for the active vehicle profile.

+ You can start navigating to your destination quickly using the recommended route, or you can select an
alternate route (Starting a Route, page 26).

« If there are specific roads you need to use or avoid, you can customize the route (Shaping Your Route,
page 29).

+ You can add multiple destinations to a route (Adding a Location to Your Route, page 29).
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Starting a Route
1 Select Where To?, and search for a location (Finding and Saving Locations, page 18).
2 Select a location.
3 Select an option:
+ To start navigating using the recommended route, select Gol.

To edit the course of the route, select & > ¢/, and add shaping points to the route (Shaping Your Route,
page 29).
The device calculates a route to the location and guides you using voice prompts and information on the map

(Your Route on the Map, page 27). A preview of the major roads in your route appears at the edge of the map
for several seconds.

If you need to stop at additional destinations, you can add the locations to your route (Adding a Location to Your
Route, page 29).

Starting a Route by Using the Map

You can start a route by selecting a location from the map.

1 Select View Map.

2 Drag and zoom the map to display the area to search.

3 If necessary, select Q to filter the displayed points of interest by category.
Location markers (colored dots) appear on the map.

4 Select an option:
+ Select a location marker.
+ Select a point, such as a street, intersection, or address location.

5 Select Gol.

Starting a Route Using the Road Trip Routes Feature

Your device can calculate routes that prefer curvy roads, hills, and fewer highways. This feature can provide a
more enjoyable drive, but it may increase the time or distance to your destination.

Select Where To? > Categories.

If necessary, select a subcategory.

Select a location.

Select °§

Use the slider to increase or decrease the length of your route.
If necessary, select <’ to add shaping points to your route.
Select Go!.
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Going Home

The first time you start a route home, the device prompts you to enter your home location.
1 Select Where To? > Go Home.

2 If necessary, enter your home location.

Editing Your Home Location
1 Select Where To? > = > Set Home Location.
2 Enter your home location.
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Changing the Route Calculation Mode
1 Select £F > Navigation > Calculation Mode.
2 Select an option:

Select Turn-by-Turn to calculate routes on streets that are faster to drive but can be longer in distance.

Select Straight Line to calculate off-road, point-to-point routes in a straight line.

Your Route on the Map

As you travel, the device guides you to your destination using voice prompts and information on the map.
Instructions for your next turn or exit, or other actions appear across the top of the map.
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Distance to the next action.

Next action in the route. Indicates the next turn, exit, or other action and the lane in which you should
travel, if available.

Name of the street or exit associated with the next action.

Route highlighted on the map.

Next action in the route. Arrows on the map indicate the location of upcoming actions.

Map tools. Provides tools to show you more information about your route and surroundings.
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Active Lane Guidance

As you approach some turns, exits, or interchanges in your route, a detailed simulation of the road appears
beside the map, if available. A colored line (1) indicates the proper lane for the turn.

Viewing Turns and Directions
While navigating a route, you can view upcoming turns, lane changes, or other directions for your route.
1 From the map, select an option:

+ To view upcoming turns and directions as you navigate, select = > Turns.

The map tool displays the next several turns or directions beside the map. The list updates automatically
as you navigate the route.

+ To view the complete list of turns and directions for the entire route, select the text bar at the top of the
map.

2 Select aturn or direction (optional).

Detailed information appears. An image of the junction may appear for junctions on major roadways, if
available.

Viewing the Entire Route on the Map
1 While navigating a route, select anywhere on the map.
2 Select B,

Arriving at Your Destination
When you approach your destination, the device provides information to help you complete your route.

- ¥ indicates the location of your destination on the map, and a voice prompt announces you are approaching
your destination.

+ When you approach some destinations while using an RV vehicle profile, the device automatically prompts
you to plan your arrival at an RV destination, such as a parking area. You can select a suggested point on the
map, and select Go! to navigate to that destination.

* When you stop at your destination, the device automatically ends the route. If the device does not detect your
arrival automatically, you can select == > Stop to end your route.
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Changing Your Active Route

Adding a Location to Your Route
Before you can add a location to your route, you must be navigating a route (Starting a Route, page 26).

You can add locations to the middle or end of your route. For example, you can add a fuel station as the next
destination in your route.

TIP: To create complex routes with multiple destinations or scheduled stops, you can use the route planner to
plan, schedule, and save a route (Route Planner, page 42).

1 From the map, select ( > Where To?.

Search for a location (Finding and Saving Locations, page 18).

Select a location.

Select Go!.

Select an option:

+ To add the location as the next destination in your route, select Add As Next Stop.

+ To add the location to the end of your route, select Add As Last Stop.

+ To add the location and edit the order of destinations in your route, select Add to Active Route.

The device re-calculates the route to include the added location and guides you to the destinations in order.
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Shaping Your Route
Before you can shape your route, you must start a route (Starting a Route, page 26).

You can manually shape your route to change its course. This allows you to direct the route to use a certain
road or go through a certain area without adding a destination to the route.

1 From the map, select = > Edit Route > Shape Route.

TIP: You can select == to zoom in on the map and select a more precise location.

The device enters route shaping mode and recalculates the route to travel through the selected location.
2 Select \/ > B
3 If necessary, select an option:

+ To add more shaping points to the route, select additional locations on the map.

+ To remove a shaping point, select the shaping point and select i

Taking a Detour

You can take a detour for a specified distance along your route or detour around specific roads. This is useful if
you encounter construction zones, closed roads, or poor road conditions.

1 From the map, select = > Edit Route.
2 Select an option:
+ To detour your route for a specific distance, select Detour by Distance.
To detour around a specific road on the route, select Detour by Road.

Stopping the Route

From the map, select = > Stop.

Using Suggested Routes

Before you can use this feature, you must save at least one location and enable the travel history feature (Device
and Privacy Settings, page 52).

Using the myTrends” feature, your device predicts your destination based on your travel history, the day of the
week, and the time of day. After you have driven to a saved location several times, the location may appear in
the navigation bar on the map, along with the estimated time of travel, and traffic information.

Select the navigation bar to view a suggested route to the location.
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Avoiding Delays, Tolls, and Areas

Avoiding Traffic Delays on Your Route

Before you can avoid traffic delays, you must be receiving traffic information (Receiving Traffic Data Using Your
Smartphone, page 41).

By default, the device optimizes your route to avoid traffic delays automatically. If you have disabled this option
in the traffic settings (Traffic Settings, page 51), you can view and avoid traffic delays manually.

1 While navigating a route, select = > Traffic.
2 Select Alternate Route, if available.
3 Select Go!.

Avoiding Toll Roads

Your device can avoid routing you through areas that require tolls, such as toll roads, toll bridges, or congestion
areas. The device may still include a toll area in your route if no other reasonable routes are available.

1 Select £¥ > Navigation > Avoidances > Tolls and Fees.
2 Select OK.

Avoiding Road Features
1 Select £¥ > Navigation > Avoidances.
2 Select the road features to avoid on your routes, and select Save.

Avoiding Environmental Zones On Your Route
Your device can avoid areas with environmental or emissions restrictions that may apply to your vehicle.

Before you can use this feature, you must add an environmental zone vehicle profile to your device (Adding an
Environmental Zone Vehicle Profile, page 7).

Before you can avoid environmental zones on your route, you must start a route.
NOTE: This feature is not available for all regions or product models.
When the device prompts you, select Go! to take an alternate route.

Custom Avoidances

Custom avoidances allow you to select specific areas or sections of road to avoid. When the device calculates a
route, it avoids these areas and roads unless no other reasonable route is available.

Avoiding a Road

Select f¥ > Navigation > Custom Avoidances.

Select Add Avoid Road.

Select the starting point of the section of road to avoid, and select Next.

Select the ending point of the road section, and select Next.

Select Done.
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Avoiding an Area
1 Select £¥ > Navigation > Custom Avoidances.

2 If necessary, select Add Avoidance.

3 Select Add Avoid Area.

4 Select the upper-left corner of the area to avoid, and select Next.
5 Select the lower-right corner of the area to avoid, and select Next.

The selected area is shaded on the map.
6 Select Done.
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Disabling a Custom Avoidance

You can disable a custom avoidance without deleting it.
1 Select £F > Navigation > Custom Avoidances.

2 Select an avoidance.

3 Select = > Disable.

Deleting Custom Avoidances
1 Select 'ﬁ' > Navigation > Custom Avoidances > ﬁ
2 Select an option:
+ To delete all custom avoidances, select Select All > Delete.
+ To delete one custom avoidance, select the avoidance, and select Delete.

Using the Map

You can use the map to navigate a route (Your Route on the Map, page 27) or to view a map of your
surroundings when no route is active.
1 Select View Map.
2 Touch anywhere on the map.
3 Select an option:

+ Drag the map to pan left, right, up, or down.

+ To zoom in or out, select + or =

+ To switch between North Up, 2D, and 3D views, select A

- To open the route planner, select £+ (Route Planner, page 42).

- To start a route, select a location on the map, and select Go! (Starting a Route by Using the Map, page 26).
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Map Tools

Map tools provide quick access to information and device functions while you view the map. When you activate
a map tool, it appears in a panel at the edge of the map.

Stop: Stops navigation of the active route.

Camera: Provides dash cam controls and displays forward collision and lane departure alerts. Also allows you
to open the dash cam viewfinder and the driver assistance settings.

Edit Route: Allows you to take a detour or skip locations in your route (Changing Your Active Route, page 29).

Mute Navigation: Mutes the device audio.

Cities Ahead: Displays upcoming cities and services along your active route or along a highway (Cities Ahead,
page 33).

Up Ahead: Displays upcoming locations along the route or the road on which you are traveling (Up Ahead,
page 32).

Elevation: Displays upcoming elevation changes.

Traffic: Displays traffic conditions along your route or in your area (Viewing Upcoming Traffic, page 34). This
feature is not available in all areas or for all device models.

Trip Data: Displays customizable trip data, such as speed or mileage (Viewing Trip Data from the Map,
page 33).

Track Recorder: Displays the track data for your active route.

Turns: Displays a list of upcoming turns in your route (Viewing Turns and Directions, page 28).

Phone: Displays a list of recent phone calls from your connected phone, and displays in-call options while a
phone call is active (Using In-Call Options, page 40).

Weather: Displays weather conditions for your area.
Music Controls: Displays media controls and media information.
Plan Arrival: Displays a map of your destination and allows you to find a truck destination.
Pilot Flying J: Displays upcoming Pilot Flying J Travel Centers” along your route.
NOTE: This feature is available only in North America.

Viewing a Map Tool
1 From the map, select =.
2 Select a map tool.
The map tool appears in a panel at the edge of the map.
3 When you are done using the map tool, select .

Up Ahead

The Up Ahead tool provides information about upcoming locations along your route or the road on which you
are traveling. You can view upcoming points of interest by category, such as restaurants, fuel stations, or rest
areas.

You can customize the categories that show in the Up Ahead tool.

Viewing Upcoming Locations
1 From the map, select = > Up Ahead.
While you are traveling, the map tool shows the next location along your road or route.
2 Select an option:
+ If the map tool shows categories, select a category to view a list of nearby locations in that category.

+ If the map tool shows upcoming locations, select a location to view location details or start a route to the
location.
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Customizing the Up Ahead Categories
You can change the location categories that appear in the Up Ahead tool.

1

2
3
4

5

From the map, select = > Up Ahead.

Select a category.

Select .

Select an option:

+ To move a category up or down in the list, select and drag the arrow next to the category name.
+ To change a category, select the category.

+ To create a custom category, select a category, select Custom Search, and enter the name of a business
or category.

Select Save.

Cities Ahead

While you are traveling on a highway or navigating a route that includes a highway, the Cities Ahead tool
provides information about upcoming cities along the highway. For each city, the map tool shows the distance
to the highway exit and the services available, similar to the information on highway road signs.

Viewing Upcoming Cities and Exit Services

1

3

From the map, select = > Cities Ahead.

While you are traveling along a highway or an active route, the map tool shows information about upcoming
cities and exits.

Select a city.

The device shows a list of points of interest located at the selected city exit, such as fuel stations, lodging, or
restaurants.

Select a location, and select Go! to start navigating.

Trip Information

Viewing Trip Data from the Map
Before you can view trip data on the map, you must add the tool to the map tools menu.

From the map, select = > Trip Data.
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Viewing Customized Trip Information on the Map

You can use the trip data map tool to show customized trip information on the map.
1 From the map, select = > Trip Data.

2 Select an option:
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Select a data field in the trip data tool (1), and select the information to show in the field.
- Select the customizable map data field (2), and select the information to show in the field.

Viewing Trip Data
The trip data tool displays your speed and provides statistics about your trip.
From the map, select Speed.

Resetting Trip Information
1 From the map, select Speed.
2 Select = > Reset Field(s).
3 Select an option:
+ When not navigating a route, select Select All to reset every data field except the speedometer, on the first
page.
+ Select Reset Overall Data to reset Trip A and total data.
+ Select Reset Trip B to reset the odometer.
+ Select Reset Max. Speed to reset the maximum speed.

Viewing Upcoming Traffic

NOTICE

Garmin is not responsible for the accuracy or timeliness of the traffic information.

Before you can use this feature, your device must be receiving traffic data (Traffic, page 41).
You can view traffic incidents coming up along your route or along the road on which you are traveling.
1 While navigating a route, select = > Traffic.
The nearest upcoming traffic incident appears in a panel on the right side of the map.
2 Select the traffic incident to view additional details.
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Viewing Traffic on the Map

The traffic map shows color-coded traffic flow and delays on nearby roads.
1 From the main menu, select == > Traffic.

2 If necessary, select = > Legend to view the legend for the traffic map.

Searching for Traffic Incidents

1 From the main menu, select == > Traffic.

2 Select = > Incidents.

3 Select an item in the list.

4 If there is more than one incident, use the arrows to view additional incidents.

Customizing the Map

Customizing the Map Layers

You can customize which data appear on the map, such as icons for points of interest and road conditions.
1 Select 'Q- > Map Display > Map Layers.

2 Select the check box next to each layer you want to show on the map.

Changing the Map Data Field

1 From the map, select a data field.
NOTE: You cannot customize Speed.

2 Select a type of data to display.

Changing the Map Perspective

1 Select £¥ > Map Display > Driving Map View.

2 Select an option:
- Select Track Up to display the map in two dimensions (2-D), with your direction of travel at the top.
+ Select North Up to display the map in 2-D with north at the top.
+ Select 3-D to display the map in three dimensions.

Live Services, Traffic, and Smartphone Features

Do not read or interact with notifications while driving, because doing so can cause distraction that could lead
to an accident resulting in serious personal injury or death.

The Garmin Drive app allows your device to receive smart notifications and live information, such as live traffic
data and weather information.

Live traffic data: Sends real-time traffic data to your device, such as traffic incidents and delays, construction
zones, and road closings (Traffic, page 41).

Weather information: Sends real-time weather forecasts, road conditions, and weather radar to your device
(Viewing the Weather Forecast, page 41).

Smart Notifications: Displays phone notifications and messages on your device. This feature is not available for
all languages.

Hands-Free calling: Allows you to place and receive phone calls using your device, and allows you to use the
device as a hands-free speaker phone. If the selected language supports the voice command feature, you can
place calls using voice commands.

Send locations to device: Allows you to send locations from your smartphone to your navigation device.
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Pairing with Your Smartphone

You can pair your Garmin device with your smartphone and the Garmin Drive app to enable additional features
and access live information(Live Services, Traffic, and Smartphone Features, page 35).

1 From the app store on your smartphone, install the Garmin Drive app.

2 Turn on your Garmin device, and place the device and your smartphone within 3 m (10 ft.) of each other.
3 On your phone, open the Garmin Drive app.
4

Follow the on-screen instructions to sign in to a Garmin account and complete the pairing and setup
process.

The main app dashboard appears. After the devices are paired, they connect automatically when they are turned
on and within range.

Disabling Bluetooth Features (Android™)

By default, all compatible Bluetooth features are enabled when you pair your phone. You can disable specific
Bluetooth features and remain connected to the other features.

1 Select 'ﬁ' > Wireless Networks.
2 Select an option:
« To disable all Bluetooth features, clear the Bluetooth check box.
+ To disable only hands-free calling, select the phone name and clear the Phone calls check box.

Showing or Hiding App Notifications (Android)

You can use the Garmin Drive app to customize which types of smartphone notifications appear on your Garmin
device.

1 On your phone, open the Garmin Drive app.
2 Select 'Q- > Smart Notifications.
A list of smartphone app categories appears.
3 Select a category to enable or disable notifications for that type of app.

Disabling Bluetooth Features (iPhone)

By default, all compatible Bluetooth features are enabled when you pair your phone. You can disable specific
Bluetooth features and remain connected to the other features.

1 Select ¥ > Wireless Networks.
2 Select an option:
To disable all Bluetooth features, clear the Bluetooth check box.
+ To disable hands-free calling, select the phone name, and clear the Phone calls check box.

Showing or Hiding Notification Categories (iPhone)
You can filter the notifications shown on your device by showing or hiding categories.
1 Select 'ﬁ' > Wireless Networks.
2 Select Smartphone services.
TIP: LT appears colored when the services are active.
3 Select Smart Notifications.
4 Select the check box next to each notification to show.
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Viewing Videos and Photos on Your Smartphone

Before you can view videos and photos on your smartphone, you must pair your Garmin device with the Garmin
Drive app (Pairing with Your Smartphone, page 36).

NOTE: The device stops recording and alerts are disabled while viewing videos or photos.
1 From the Garmin Drive app on your smartphone, select Videos and Photos.
2 Select an option:
To view a photo or video you saved, select a file from the Saved category.
+ To view recent video footage that has not been saved, select a video from the Temporary category.

Deleting a Video or Photo Using Your Smartphone

1 When you are viewing the list of saved videos or photos on your smartphone, select Select.
2 Select one or more files.

3 Select ﬁ

Bluetooth Feature Status Icons

Status icons appear in the Bluetooth settings next to each paired device.
Select 'Q' > Wireless Networks.

+ A gray icon indicates the feature is disabled or disconnected for that device.
« A colored icon indicates the feature is connected and active for that device.

, Hands-free calling
LT Smart notifications
@J: Garmin Drive features and services

Smart Notifications
While your device is connected to the Garmin Drive app, you can view notifications from your smartphone on
your Garmin device, such as text messages, incoming calls, and calendar appointments.

NOTE: You may need to wait a few minutes to receive notifications on your navigation device after it connects
to the Garmin Drive app. ey appears colored in the Bluetooth settings when smart notifications are connected
and active (Bluetooth Feature Status Icons, page 37).
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Receiving Notifications

Do not read or interact with notifications while driving, because doing so can cause distraction that could lead
to an accident resulting in serious personal injury or death.

Before you can use this feature, your device must be connected to a supported phone running the Garmin Drive
app (Live Services, Traffic, and Smartphone Features, page 35).

From most pages, a popup appears when the device receives a notification from your smartphone. If the device
is moving, you must verify you are a passenger and not the driver before you can view notifications.

NOTE: If you are viewing the map, notifications appear in a map tool.
+ To ignore a notification, select OK.
The popup closes, but the notification remains active on your phone.
+ To view a notification, select View.
+ To listen to the notification, select View > Play.

The device reads the notification using text-to-speech technology. This feature is not available for all
languages.

+ To perform additional actions, such as dismissing the notification from your phone, select View, and select
an option.

NOTE: Additional actions are available for only some notification types and must be supported by the app
generating the notification.

Receiving Notifications while Viewing the Map

Do not read or interact with notifications while driving, because doing so can cause distraction that could lead
to an accident resulting in serious personal injury or death.

Before you can use this feature, your device must be connected to a supported phone running the Garmin Drive
app (Live Services, Traffic, and Smartphone Features, page 35).

When you are viewing the map, new notifications appear in a map tool at the edge of the screen. If the device is
moving, you must verify you are a passenger and not the driver before you can view notifications.

+ Toignore a notification, select K or wait for popup to expire.

The popup closes, but the notification remains active on your phone.
+ To view a notification, select the notification text.
+ To listen to the notification, select Play Message.

The device reads the notification using text-to-speech technology. This feature is not available for all
languages.

Viewing the List of Notifications
You can view a list of all active notifications.
1 Select == > Smart Notifications.
The list of notifications appears. Unread notifications appear black, and previously read notifications appear
gray.
2 Select an option:
+ To view a notification, select the notification description.
+ To listen to a notification, select }

The device reads the notification using text-to-speech technology. This feature is not available for all
languages.
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Going to an Address or Location Using the Garmin Drive App

You can use the Garmin Drive app to search for an address, business, or point of interest, and send it to your
Garmin device for navigation.

1 From the Garmin Drive app, select Where To?.
2 Select an option:
+ To search for an address near you, enter the house number and street name.
To search for an address in another city, enter the house number, street name, city, and state.
+ To search for a business name, enter all or part of the name.
To search for a city, enter the city and state.
As you type, suggestions appear below the search field.
3 Select a suggested search result.
The app displays the location on a map.
4 Select Go! to start a route.

The Garmin device starts navigating to the selected location, and the location is added to your recent searches
in the Where To? menu.

Hands-Free Calling

NOTE: While most phones are supported and can be used, it cannot be guaranteed that a particular phone can
be used. All features may not be available for your phone.

Using Bluetooth wireless technology, your device can connect to your mobile phone to become a hands-free
device (Live Services, Traffic, and Smartphone Features, page 35). While connected, you can place or receive
calls using your device.

Placing a Call

Dialing a Number

1 Select == > Phone > Dial.
2 Enter the number.

3 Select Dial.

Calling a Contact in Your Phone Book

Your phone book is loaded from your phone to the device each time your phone and the device connect. It may
take a few minutes for the phone book to be available. Some phones do not support this feature.

1 Select g@ > Phone > Phone Book.
2 Select a contact.
3 Select Call.

Calling a Location

1 Select == > Phone > Browse Categories.
2 Select a point of interest.

3 Select = > Call.

Receiving a Call
When you receive a call, select Answer or Ignore.
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Using the Call History

Your call history is loaded from your phone to the device each time your phone and the device connect. It may
take a few minutes for the call history to be available. Some phones do not support this feature.

1 Select == > Phone > Call History.
2 Select a category.

A list of calls appears, with the most recent calls at the top.
3 Selectacall.

Using In-Call Options
In-call options are available when you answer a call. Some options may not be compatible with your phone.

TIP: If you close the in-call options page, you can open it again by selecting J from any screen. You can also
select the caller from the map.

+ To set up a conference call, select Add Call.
+ To transfer audio to your phone, select Call in Progress Navigator.

TIP: You can use this feature if you want to disconnect the Bluetooth connection and remain on the call, or if
you need privacy.

+ To use the dial pad, select Keypad.

TIP: You can use this feature to use automated systems, such as voice mail.
+ To mute the microphone, select Mute.
+ To hang up, select End Call.

Saving a Home Phone Number

TIP: After you save a home number, you can edit the home number by editing “Home” in your list of saved
locations (Editing a Saved Location, page 25).

1 Select == > Phone > = > Set Home Number.
2 Enter your phone number.
3 Select Done.

Calling Home
Before you can call home, you must enter a phone number for your home location.
Select == > Phone > Call Home.

Disconnecting a Bluetooth Device

You can temporarily disconnect a Bluetooth device without deleting it from the paired devices list. The
Bluetooth device can connect to your Garmin device automatically in the future.

1 Select Q > Wireless Networks.
2 Select the device to disconnect.
3 Select Disconnect.

Deleting a Paired Phone

You can delete a paired phone to prevent it from automatically connecting to your device in the future.
1 Select 'ﬁ' > Wireless Networks.

2 Select the phone, and select Forget Device.
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Traffic

Garmin is not responsible for the accuracy or timeliness of the traffic information.

Your device can provide information about traffic on the road ahead or on your route. You can set your device to
avoid traffic when calculating routes, and to find a new route to your destination if a large traffic delay occurs on
your active route (Traffic Settings, page 51). The traffic map allows you to browse the map for traffic delays in
your area.

To provide traffic information, your device must be receiving traffic data.
All product models can receive subscription-free traffic data using the Garmin Drive app.
Traffic data is not available in all areas. For information about traffic coverage areas, go to garmin.com/traffic.

Receiving Traffic Data Using Your Smartphone

Your device can receive subscription-free traffic data while connected to a smartphone running the Garmin
Drive app.

1 Connect your device to the Garmin Drive app (Live Services, Traffic, and Smartphone Features, page 35).
2 Onyour Garmin device, select L} > Traffic > Traffic, and verify the Traffic option is selected.

Enabling Traffic

You can enable or disable traffic data.
1 Select 'Q' > Traffic.

2 Select the Traffic check box.

Using the Apps

Viewing the Owner’s Manual on Your Device
You can view the complete owner's manual on the device screen in many languages.
1 Select g@ > Owner's Manual.

The owner's manual appears in the same language as the software text (Language and Keyboard Settings,
page 51).
2 Select Q to search the owner's manual (optional).

Viewing the Weather Forecast

NOTICE

Garmin is not responsible for the accuracy or timeliness of the weather data.

Before you can use this feature, your device must be receiving weather data. You can connect your device to the
Garmin Drive app to receive weather data (Live Services, Traffic, and Smartphone Features, page 35).

NOTE: Weather forecasts are not available in all areas.

1 Select == > Weather.

The device shows the current weather conditions and a forecast for the next several days.
2 Select a day.

The detailed forecast for that day appears.
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Viewing Weather Near a Different City
1 Select == > Weather > Current Location.
2 Select an option:
+ To view weather for a favorite city, select a city in the list.
+ To add a favorite city, select Add City, and enter a city name.

Viewing the Weather Radar

Before you can use this feature, your device must be connected to a supported phone running the Garmin Drive
app (Live Services, Traffic, and Smartphone Features, page 35).

1 Select == > Weather Radar.
2 Select } to animate the radar map.

Viewing Weather Alerts

Before you can use this feature, your device must be connected to a supported phone running the Garmin Drive
app (Live Services, Traffic, and Smartphone Features, page 35).

NOTE: This feature is not available in all areas.

While you are traveling with your device, weather alerts may appear on the map. You can also view a map of
weather alerts near your current location or near a selected city.

1 Select == > Weather.
2 |If necessary, select a city.
3 Select = > Weather Alerts.

Checking Road Conditions

Before you can use this feature, your device must be connected to a supported phone running the Garmin Drive
app (Live Services, Traffic, and Smartphone Features, page 35).

You can view weather-related road conditions for the roads in your area, on your route, or in another city.
1 Select == > Weather.

2 If necessary, select a city.

3 Select = > Road Conditions.

Route Planner

You can use the route planner to create and save a route, which you can navigate later. This can be useful for
planning a delivery route, a vacation, or a road trip. You can edit a saved route to further customize it, including
reordering locations, adding suggested attractions, and adding shaping points.

You can also use the route planner to edit and save your active route.

Planning a Route

A route can include many locations, and it must include at least a starting location and one destination. The
starting location is the location from which you plan to start your route. If you start navigating the route from
a different location, the device gives you the option to route to your starting location first. For a round trip, the
starting location and final destination can be the same.

Select == > Route Planner > Create Route.

Select Select Start Location.

Choose a location for your starting point, and select Select.

Select Select Destination.

Choose a location for a destination, and select Select.

Select Add Location to add more locations (optional).

After you have added all the necessary locations, select Next > B.
Enter a name, and select Done.
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Editing and Reordering Locations in a Route

1 Select Route Planner.

Select a saved route.

Select List.

Select a location.

Select an option:

+ To change the location, select R and enter a new location.

- To move the location up or down, select §f, and drag the location to a new position in the route.
- To add a new location after the selected location, select (¥).

+ To remove the location, select ﬁ
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Changing Routing Options for a Route
You can customize how the device calculates your route.
1 Select == > Route Planner.
2 Select a saved route.
3 Select .
4 Select an option:
+ To add shaping points to your route, select &/, and select at least one location.
+ To change the calculation mode for the route, touch a route segment, and select a calculation mode.

Navigating to a Saved Route

1 Select g@ > Route Planner.

Select a saved route.

Select Go!.

Select the first location to navigate to, and select OK.
Select OK.

The device calculates a route from your current location to the selected location, and then it guides you to
the remaining route destinations in order.
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Editing and Saving Your Active Route
If a route is active, you can use the route planner to edit and save it.
1 Select == > Route Planner > My Active Route.
2 Edit your route using any of the route planner features.
The route recalculates each time you make a change.
3 Select OK to save your route, which you can navigate again later (optional).

Loyalty Programs

From your Garmin device, you can access loyalty programs from some of the travel plazas in the United States,
including Pilot Flying J Travel Centers. You can use the loyalty program apps on your Garmin device to check
reward points balances and other loyalty program information. To activate loyalty program features, sign in to
your loyalty program account in the Garmin Drive app.

NOTE: This feature is available only in the United States.
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Logging Service History

You can log the date and odometer reading when service or maintenance is performed on your vehicle. The
device provides several service categories, and you can add custom categories (Adding Service Categories,

page 44).

Select == > Service History.

Select a service category.

Select Add Record.

Enter the odometer reading, and select Next.
Enter a comment (optional).

Select Done.
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Adding Service Categories

1 Select == > Service History.

2 Select = > Add Category.

3 Enter a category name, and select Done.

Deleting Service Categories

When you delete a service category, all service records in the category are also deleted.

1 Select == > Service History.

2 Select = > Delete Categories.

3 Select the service categories to delete.
4 Select Delete.

Renaming Service Categories

1 Select == > Service History.

2 Select the category to be renamed.
3 Select = > Rename Category.

4 Enter a name, and select Done.

Editing a Service Record

You can edit the comment, odometer reading, and date of a service record.

1 Select == > Service History.

2 Select a category.

3 Select afield.

4 Enter the new information, and select Done.

Deleting Service Records

1 Select == > Service History.

Select a service category.

Select = > Delete Records.

Select the service records to be deleted.
Select Delete.
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Garmin PowerSwitch™ App

PowerSwitch-4E7C 13.95V 4 0AMP Load
_ j_:_'; & Custom Layout 0

@ -a- Opens the app settings menu
@ EJ" Enters editing mode to customize the app layout and functions

@ d) Turns off all outputs

@ Power buttons Activates each connected output

@ Displays input voltage

@ Displays the total amperage of the selected Garmin PowerSwitch device
@ Displays the device name

Displays Garmin PowerSwitch device tabs and custom layout tabs

Activating a Power Switch

Before you can use the Garmin PowerSwitch app to activate a switch, you must install your Garmin
PowerSwitch device in your vehicle and pair it with the Garmin PowerSwitch app.

From the Garmin PowerSwitch app, select a power button to turn a switch on or off.

Turning Off All Switches
Select (')
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Customizing a Button

From the Garmin PowerSwitch app screen, select B
The app enters editing mode.

Select (% on the button you want to customize.
Select an option:

1

4
5

To change the name of the button, select the Button Label field, and enter a name.

To add an icon to the button, select the Icon field, and select an icon.
To change the button color, select a color.

To change the button mode, select a button mode.

To adjust the intensity of the switch, use the slider.

To set the button to activate with a control input, select a control input.

Select <
Select Done.

Assigning a Switch to a Control Input

Before you can use control input functions, you must connect a control input to your Garmin PowerSwitch
device.

You can assign one or more switches to turn on when the Garmin PowerSwitch device receives a signal from a
control input.

Select Q‘

Select your Garmin PowerSwitch device.
Select a control input.

Select one or more switches.

1

2
3
4

Adding a Custom Layout

You can add a custom layout tab to the Garmin PowerSwitch app. Buttons added to a custom layout can control
multiple switches at the same time.

1 From the Garmin PowerSwitch app, select E]".
The device enters editing mode.
2 Select +
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Adding a Button to a Custom Layout
1 From the Garmin PowerSwitch app, select a custom layout tab.
2 Select (.
The app enters editing mode.
3 Select Add Button.
4 On the new button, select (.
5 Select an option:
+ To change the name of the button, select the Button Label field, and enter a name.
To add an icon to the button, select the Icon field, and select an icon.
+ To change the button color, select a color.
6 Select Add Action.
7 If necessary, select a Garmin PowerSwitch device and a switch.
8 Select an action:
+ To set the button to turn the switch on or off with each press, select Toggle.
To set the button to turn on the switch, select Turn On.
« To set the button to turn off the switch, select Turn Off.
9 Select a button mode:
+ To set the button to activate with one touch, select Normal.
To set the button to activate only while touching the button, select Momentary.
+ To set the button to turn on and off repeatedly, select Strobe, and select time intervals.
10 If applicable, use the slider to set the brightness of lights.
11 Select (
12 If necessary, select Add Action to add additional actions for the button.
You can add one action for every switch on the Garmin PowerSwitch device.

Arranging Buttons In a Custom Layout
1 From the Garmin PowerSwitch app, select a custom layout tab.
2 Select (.
The app enters editing mode.
3 On the button you want to move, hold c3 and drag the button to a new location.

Deleting a Custom Layout or Button
1 From the Garmin PowerSwitch app, select a custom layout tab.
2 Select .
The app enters editing mode.
3 Select an option:
- To delete a button, select Ifj on the button you want to delete.
+ To delete a layout tab, select il on the layout tab.

Routines

Routines automate your Garmin PowerSwitch device. When you define a routine on your compatible Garmin
navigation device, it turns switches on or off automatically when the conditions of the routine are met. For
example, you can set a routine to turn on a switch at specific time each day or when your vehicle reaches a
specific speed. Routines are available only when using a compatible Garmin navigation device.
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Adding a Routine

1 From the Garmin PowerSwitch app, select 'ﬁ > Routines.
2 If necessary, select Add Routine.

3 Select When.

4 Select atrigger:

+ To set a switch to trigger when your vehicle reaches a specific speed, select Speed > Next, and follow the
on-screen instructions to enter speed thresholds.

To set a switch to trigger at a specific time each day, select Time > Next, and enter a time.
+ To set a switch to trigger at sunrise, select Sunrise.
To set a switch to trigger at sunset, select Sunset.
Select Add Action.
Select a device, a switch, an action, and a button mode.
If necessary, use the slider to adjust the dimmer.
Select Save.
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Editing a Routine
1 From the Garmin PowerSwitch app, select ¥ > Routines.
2 Select %\ on the routine you want to edit.
3 Select an option:
+ To change the trigger for the routine, select When, and select a trigger.
+ To change an action, select ¥\ on the action you want to change, and update the action.
+ To add an action to the routine, select Add Action, and enter information about the action.
4 Select Save.

Deleting a Routine
1 From the Garmin PowerSwitch app, select £¥ > Routines.
2 Select i on the routine you want to delete.

Settings

Map and Vehicle Settings

Select 'Q' > Map Display.

Map Vehicle Icon: Sets the vehicle icon that represents your position on the map.

Driving Map View: Sets the perspective on the map.

Map Detail: Sets the level of detail on the map. More detail may cause the map to draw slower.
Map Theme: Changes the color of the map data.

Map Layers: Sets the data that appears on the map page (Customizing the Map Layers, page 35).

Auto Zoom: Automatically selects the zoom level for optimal use of your map. When disabled, you must zoom
in or out manually.

Skip Next Stop Confirmation: Sets a confirmation message to appear when skipping a location on your route.
myMaps: Sets which installed maps the device uses.

Enabling Maps

You can enable map products installed on your device.

TIP: To purchase additional map products, go to garmin.com/maps.
1 Select £¥ > Map Display > myMaps.

2 Select a map.
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Navigation Settings

Select ¥ > Navigation.

Calculation Mode: Sets the route calculation method.
Avoidances: Sets road features to avoid on a route.

Custom Avoidances: Allows you to avoid specific roads or areas.

Environmental Zones: Sets the avoidance preferences for areas with environmental or emissions restrictions
that may apply to your vehicle.

Restricted Mode: Disables all functions that require significant operator attention.
GPS Simulator: Stops the device from receiving a GPS signal, and saves battery power.

Setting a Simulated Location

If you are indoors or not receiving satellite signals, you can use the GPS simulator to plan routes from a
simulated location.

1 Select £¥ > Navigation > GPS Simulator.
2 From the main menu, select View Map.
3 Tap the map twice to select an area.
The address of the location appears at the bottom of the screen.
4 Select the location description.
5 Select Set Location.

Wireless Network Settings

The wireless network settings allow you to manage Wi-Fi networks, paired Bluetooth devices, and Bluetooth
features.

Select 'Q' > Wireless Networks.
Bluetooth: Enables Bluetooth wireless technology.

Paired Device Name: The names of paired Bluetooth devices appear in the menu. You can select a device name
to change Bluetooth feature settings for that device.

Search for Devices: Searches for nearby Bluetooth devices.

Friendly Name: Allows you to enter a friendly name that identifies your device on other devices with Bluetooth
wireless technology.

Wi-Fi: Enables the Wi-Fi technology.
Saved Networks: Allows you to edit or remove saved networks.
Search for Networks: Searches for nearby Wi-Fi networks (Connecting to a Wi-Fi Network, page 53).

Driver Assistance Settings
Select 'Q' > Driver Assistance.

Driver Alerts: Allows you to enable or disable alerts for upcoming zones or road conditions (Driver Awareness
Features and Alerts, page 13).

Speeding Alert: Alerts you when you are exceeding the speed limit.

Reduced Speed Tone: Alerts you when the speed limit decreases.

Route Preview: Displays a preview of the major roads in your route when you start navigation.
Proximity Alerts: Alerts you when you approach speed cameras or red light cameras.

Plan Arrival: Displays a map of your destination at the end of a route. You can also enable your device to
download satellite imagery using the mobile data on your paired smartphone.

Forward Collision Warning: Allows you to enable and set the sensitivity of the forward collision warning. A
higher sensitivity alerts you sooner than a lower sensitivity.

Lane Departure Warning: Enables the device to alert you when it detects you may be crossing a lane boundary
unintentionally.
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Proximity Alerts Settings

NOTE: You must have custom points of interest (POls) loaded for proximity points alerts to display.
NOTE: This feature is not available in all areas.

Select %¥ > Driver Assistance > Proximity Alerts.

Audio: Sets the style of alert that plays when you approach proximity points.

Alerts: Sets the type of proximity points for which alerts are played.

Dash Cam Settings
Select 'Q' > Dash Cam.

Camera Placement: Allows you to set the vehicle height and camera position, and align the dash cam (Aligning
the Camera, page 8).

Record on Startup: Enables the dash camera to start recording video automatically when you turn on the device.
Video Resolution: Sets the resolution and quality for dash cam recordings.

Incident Detection: Sets the sensitivity for incident detection features. The device saves video automatically
when the it detects a possible driving incident.

Record Audio: Enables or disables audio recording while you are recording with the dash cam.
Data Overlay: Includes date, time, location, and speed information in the recorded video.

Unsaved Videos: Determines when the device deletes unsaved video footage. When the Delete When Full option
is selected, the device deletes the oldest unsaved video when the memory card storage is full. When the
Promptly Delete option is selected, the device continually deletes unsaved video more than three minutes old
and deletes all unsaved video each time it is powered off. This is useful to help protect data privacy. While
the Promptly Delete option is selected, you cannot view unsaved video in the gallery.

Wireless Camera Settings

The wireless camera settings allow you to manage paired Garmin wireless cameras and camera settings.
Settings in this menu only appear when a wireless camera is connected to your Garmin device. See the manual
for your wireless camera for more information about pairing a wireless camera with your Garmin device.

Backup Camera Settings

Select £ > Wireless Camera, and select the backup camera name.

Flip Video: Allows you to flip or mirror the video.

Guidance Lines: Sets preferences for guidance lines displayed on the camera video.
Rename: Allows you to rename the paired camera.

Set Default Camera: Sets the order in which cameras appear in the camera view. The camera at the top of the
list is the default camera and appears first each time the camera view appears.

Unpair: Removes the paired camera.

Automatic Activation: Enables the Garmin navigation device to display the default camera view automatically
each time the navigation device is turned on. If the navigation device is connected to an ignition-switched
power outlet, this feature allows you to view the backup camera automatically when you start your vehicle.

Video Resolution: Allows you to set the quality of the camera video. Higher resolution settings provide a more
detailed image but use more battery power.

NOTE: This setting is not available for all navigation device product models.
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Display Settings
Select £¥ > Display.

Color Mode: Allows you to select day or night color mode. If you select the Auto option, the device automatically
switches to day or night colors based on the time of day.

Brightness: Allows you to adjust the display brightness.

Display Timeout: Allows you to set the amount of idle time before your device enters sleep mode while using
battery power.

Screenshot: Allows you to take a picture of the device screen. Screenshots are saved in the Screenshot folder of
the device storage.

Traffic Settings
From the main menu, select Q > Traffic.
Traffic: Enables the traffic feature.

Current Provider: Sets the traffic provider to use for traffic data. The Auto option selects the best available
traffic data automatically.

Subscriptions: Lists the current traffic subscriptions.

Optimize Route: Enables the device to use optimized alternate routes automatically or upon request (Avoiding
Traffic Delays on Your Route, page 30).

Units and Time Settings

To open the Units and Time settings page, from the main menu, select L+ > Units & Time.
Current Time: Sets the device time.

Time Format: Allows you to select a 12-hour, 24-hour, or UTC display time.

Units: Sets the unit of measure used for distances.

Position Format: Sets the coordinate format and datum used for geographical coordinates.

Setting the Time

1 From the main menu, select the time.

2 Select an option:
To set the time automatically using GPS information, select Automatic.
To set the time manually, drag the numbers up or down.

Language and Keyboard Settings

To open the Language and Keyboard settings, from the main menu, select > Language & Keyboard.
Voice Language: Sets the language for voice prompts.

Text Language: Sets all on-screen text to the selected language.

NOTE: Changing the text language does not change the language of user-entered data or map data, such as
street names.

Keyboard Language: Enables keyboard languages.
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Device and Privacy Settings
Select 'Q' > Device.

About: Displays the software version number, the unit ID number, and information on several other software
features.

Regulatory: Displays regulatory markings and information.
EULAs: Displays the end-user license agreements.
NOTE: You need this information when you update the system software or purchase additional map data.
Software Licenses: Displays software licensing information.
Device Data Reporting: Shares anonymous data to improve the device.

Travel History: Allows the device to store a record of the places you go. This allows you to view the trip log, use
the Trip History feature, and use myTrends suggested routes.

Reset: Allows you to clear your travel history, reset settings, or delete all user data.

Restoring Settings

You can restore a category of settings or all settings to the factory default values.
1 Select 'Q'

2 If necessary, select a settings category.

3 Select = > Restore.

Device Information

Viewing E-label Regulatory and Compliance Information
1 From the settings menu, swipe to the bottom of the menu.
2 Select Device > Regulatory.
Specifications
Operating temperature range From -20° to 55°C (from -4° to 131°F)
Charging temperature range From 0° to 45°C (from 32° to 113°F)

Vehicle power using the included vehicle power cable. AC power using an

HOAL optional accessory (for home and office use only).
Battery type Rechargeable lithium-ion
Charging the Device

NOTE: This Class Il product shall be powered by an LPS power supply.
You can charge the battery in the device using any of these methods.
Connect the device to vehicle power.
Connect the device to an optional power adapter accessory, such as a wall power adapter.

You can purchase an approved Garmin AC-DC adapter suitable for home or office use from a Garmin dealer
or www.garmin.com. The device may charge slowly when connected to a third-party adapter.

Device Maintenance

Garmin Support Center

Go to support.garmin.com for help and information, such as product manuals, frequently asked questions,
videos, and customer support.
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Map and Software Updates
For the best navigation experience, you should keep the maps and software on your device up to date.

Map updates provide the newest available changes to roads and locations in the maps used by your device.
Keeping maps up to date helps your device find recently added locations and calculate more accurate routes.
Map updates are large and may take several hours to complete.

Software updates provide changes and improvements to the device features and operation.
You can update your device using two methods.

+ You can connect the device to a Wi-Fi network to update directly on the device (recommended). This option
allows you to update your device conveniently without connecting it to a computer.

+ You can connect the device to a computer and update it using the Garmin Express application (garmin.com
/express).

Connecting to a Wi-Fi Network

The first time you turn on the device, it prompts you to connect to a Wi-Fi network and register your device. You

can also connect to a Wi-Fi network using the settings menu.
1 Select 'a' > Wireless Networks.
2 If necessary, select Wi-Fi to enable Wi-Fi technology.
3 Select Search for Networks.
The device displays a list of nearby Wi-Fi networks.
4 Select a network.
5 If necessary, enter the password for the network, and select Done.

The device connects to the network, and the network is added to the list of saved networks. The device
reconnects to this network automatically when it is within range.

Device Maintenance
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Updating Maps and Software Using a Wi-Fi Network

NOTICE
Map and software updates may require the device to download large files. Regular data limits or charges from
your internet service provider apply. Contact your internet service provider for more information about data
limits or charges.

You can update the maps and software by connecting your device to a Wi-Fi network that provides access to the
internet. This allows you to keep your device up to date without connecting it to a computer.

1 Connect the device to a Wi-Fi network (Connecting to a Wi-Fi Network, page 53).

While connected to a Wi-Fi network, the device checks for available updates. When an update is available, @
appears on the L¥ icon in the main menu.

2 Select £ > Updates.

The device checks for available updates. When an update is available, Update Available appears below Map
or Software.

3 Select an option:
+ Toinstall all available updates, select Install All.
+ Toinstall only map updates, select Map > Install All.
+ Toinstall only software updates, select Software > Install All.
4 Read the license agreements, and select Accept All to accept the agreements.

NOTE: If you do not agree with the license terms, you can select Reject. This stops the update process. You
cannot install updates until you accept the license agreements.

5 Using the included USB cable, connect the device to external power, and select Continue (Charging the
Device, page 52).
For the best results, a USB wall charger that provides at least 2 A power output is recommended. Many
USB power adapters for smartphones, tablets, or portable media devices may be compatible.

6 Keep the device connected to external power and within range of the Wi-Fi network until the update process
is complete.

TIP: If a map update is interrupted or canceled before it completes, your device may be missing map data. To
repair missing map data, you must update the maps again using either Wi-Fi or Garmin Express.
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Updating Maps and Software with Garmin Express

You can use the Garmin Express application to download and install the latest map and software updates for
your device.

1

If you do not have the Garmin Express application installed on your computer, go to garmin.com/express and
follow the on-screen instructions to install it (Installing Garmin Express, page 56).

Open the @ Garmin Express application.
Connect your device to your computer using a USB cable.

The small end of the cable connects to the USB port (1) on your Garmin device, and the large end connects to
an available USB port on your computer.

From your Garmin device, select Tap to Connect to Computer.

When your Garmin device prompts you to enter file transfer mode, select Continue.

In the Garmin Express application, click Add a Device.

The Garmin Express application searches for your device and displays the device name and serial number.
Click Add Device, and follow the on-screen instructions to add your device to the Garmin Express application.
When setup is complete, the Garmin Express application displays the updates available for your device.

Updates Available

Last Checked: Just Now

Estimated Install Time: 1 hour and 18 minutes
View Details

Select an option:
+ Toinstall all available updates, click Install All.
+ Toinstall a specific update, click View Details, and click Install next to the update you want.

The Garmin Express application downloads and installs the updates onto your device. Map updates are very
large, and this process may take a long time on slower internet connections.

NOTE: If a map update is too large for the internal storage of the device, the software may prompt you to
install a microSD card in your device to add storage space (Installing a Memory Card for Maps and Data,
page 59).

Follow the on-screen instructions during the update process to finish installing updates.

For example, during the update process, the Garmin Express application may instruct you to disconnect and
reconnect your device.
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Installing Garmin Express

The Garmin Express application is available for Windows® and Mac® computers.
1 On your computer, go to garmin.com/express.

2 Select an option:

To view the system requirements and verify the Garmin Express application is compatible with your
computer, select System Requirements.

+ Toinstall on a Windows computer, select Download for Windows.
To install on a Mac computer, select Download for Mac.
3 Open the downloaded file, and follow the on-screen instructions to complete the installation.

Device Care

NOTICE

Avoid dropping your device.

Do not store the device where prolonged exposure to extreme temperatures can occur, because it can cause
permanent damage.

Never use a hard or sharp object to operate the touchscreen, or damage may result.
Do not expose the device to water.

Cleaning the Outer Casing

NOTICE

Avoid chemical cleaners and solvents that can damage plastic components.

1 Clean the outer casing of the device (not the touchscreen) using a cloth dampened with a mild detergent
solution.

2 Wipe the device dry.

Cleaning the Touchscreen

1 Use a soft, clean, lint-free cloth.

2 |If necessary, lightly dampen the cloth with water.

3 If using a dampened cloth, turn off the device and disconnect the device from power.
4 Gently wipe the screen with the cloth.

Cleaning the Camera Lens

NOTICE

Avoid chemical cleaners and solvents that can damage plastic components.

You should clean the camera lens regularly to improve the quality of recorded video.
1 Wipe the lens with a non-scratch lens cloth, optionally dampened with isopropyl alcohol.
2 Allow the lens to air dry.

Avoiding Theft

+ Remove the device and mount from sight when not in use.

+ Remove the residue left on the windshield by the suction cup.
+ Do not keep your unit in the glove compartment.

Restarting the Device
You can restart your device if it stops functioning.
Hold the power button for 12 seconds.
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Removing the Device, Mount, and Suction Cup

Removing the Device from the Mount
1 Press the release tab or button on the mount.
2 Tilt the top of the device downward, and lift the device from the mount.

Removing the Mount from the Suction Cup
1 If necessary loosen the nut that secures the mount to the suction cup ball.
2 Turn the device mount to the right or left.

3 Apply pressure until the socket on the mount releases the ball on the suction cup.

Removing the Suction Cup from the Windshield
1 Flip the lever on the suction cup toward you.
2 Pull the tab on the suction cup toward you.

Troubleshooting

My video recordings are blurry
+ Clean the camera lens (Cleaning the Camera Lens, page 56).
Clean the windshield in front of the camera.

Verify the area of the windshield in front of the camera is cleared by the windshield wipers, and move the

device, if necessary.

My video recordings are choppy or incomplete

For the best camera and video results, use a high-quality memory card with a speed rating of class 10 or

higher.
A slower memory card may not record video quickly enough.

If you are viewing videos on your smartphone using a wireless connection to the camera, try viewing them in
another location with less wireless interference, or try transferring videos to the smartphone.

Transfer important recordings to a computer or smartphone, and format the memory card .

If the device displays a memory card error alert, first try formatting the memory card and then, if necessary,
replace the memory card (Installing the Dash Camera Memory Card, page 2).

Update your device to the latest software (Map and Software Updates, page 53).
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My memory card has degraded and needs to be replaced

All microSD memory cards wear out after they are overwritten a large number of times. Periodically formatting
the card can extend the useful life and improve performance. Because the dash camera records continuously,
you may need to replace the memory card periodically (Installing the Dash Camera Memory Card, page 2).
Your device detects memory card errors automatically and alerts you when it is time to format or replace your
memory card.

You can take these actions to help extend the useful life of the memory card.
Format the memory card at least one time every six months .

If the device displays a memory card error alert, first try formatting the memory card and then, if necessary,
replace the memory card (Installing the Dash Camera Memory Card, page 2).

Turn off the device when your vehicle is not in use.

If your device is not connected to an ignition-switched vehicle power outlet, you should turn off the device
when your vehicle is not in use to prevent the dash camera from recording unneeded footage.

Use a memory card with a higher storage capacity.

Because higher-capacity memory cards are overwritten less frequently, they usually last longer.
Use a high-quality memory card with a speed rating of class 10 or higher.

Purchase your replacement memory card from a high-quality manufacturer and a reputable vendor.

The suction cup will not stay on my windshield

1 Clean the suction cup and windshield with rubbing alcohol.

2 Dry with a clean, dry cloth.

3 Mount the suction cup (Mounting and Powering the Garmin Device in Your Vehicle, page 3).

My device is not acquiring satellite signals
Verify the GPS simulator is turned off (Navigation Settings, page 49).
Take your device out of parking garages and away from tall buildings and trees.
Remain stationary for several minutes.

The device does not charge in my vehicle
Verify the vehicle is turned on and is supplying power to the power outlet.

Verify the interior temperature of the vehicle is within the charging temperature range indicated in the
specifications.

In the vehicle fuse box, verify the fuse for the vehicle power outlet is not broken.

My battery does not stay charged for very long
Decrease the screen brightness (Display Settings, page 51).
Shorten the display timeout (Display Settings, page 51).
Decrease the volume (Adjusting the Volume, page 6).
Turn off the wi-fi radio when it is not in use (Wireless Network Settings, page 49).
Put the device in power saving mode when not in use (Turning the Device On or Off, page 4).
Keep your device away from extreme temperatures.
Do not leave your device in direct sunlight.
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My device does not connect to my phone
+ Select 'Q' > Wireless Networks > Bluetooth.
The Bluetooth option must be enabled.
Enable Bluetooth wireless technology on your phone and bring your phone within 10 m (33 ft.) of the device.
Verify your phone is compatible.
Go to www.garmin.com/bluetooth for more information.
Complete the pairing process again.

To repeat the pairing process, you must unpair your phone and device (Deleting a Paired Phone, page 40), and
complete the pairing process (Live Services, Traffic, and Smartphone Features, page 35).

Appendix
Installing a Memory Card for Maps and Data

You can install a memory card to increase the storage space for maps and other data on your device. You can
purchase memory cards from an electronics supplier. The device supports microSD memory cards from 8 to
512 GB. Memory cards must use the FAT32 file system format.

1 Locate the map and data memory card slot on your device (Garmin® Device Overview, page 1).
2 Insert a memory card into the slot.
3 Pressitin until it clicks.

Data Management
The device has a memory card slot for additional data storage.
NOTE: The device is compatible with Windows 7 and newer, and Mac OS 10.7 and newer.

About Memory Cards

You can purchase memory cards from an electronics supplier, or purchase pre-loaded Garmin mapping
software (www.garmin.com). Memory cards can be used to store files such as maps and custom POls.

Formatting the Dash Cam Memory Card

The dash cam requires a memory card formatted using the FAT32 file system. You can use the device to format
your card using this file system.

You should format your memory card at least one time every 6 months to help extend the useful life of the
memory card. You must also format a brand new memory card if it is not formatted using the FAT32 file
system.

NOTE: Formatting the memory card deletes all data on the card.
1 Select == > Gallery.
2 Select = > Format Memory Card.

Connecting the Device to Your Computer

You can connect the device to your computer using a USB cable.

1 Plug the small end of the USB cable into the port on the device.

2 Plug the larger end of the USB cable into a port on your computer.

3 From your Garmin device, select Tap to Connect to Computer.

4 When your Garmin device prompts you to enter file transfer mode, select Continue.
A picture of your device connected to a computer appears on the device screen.

Depending on your computer operating system, the device appears as either a portable device, a removable
drive, or a removable volume.
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Transferring Data From Your Computer
1 Connect the device to your computer (Connecting the Device to Your Computer, page 59).

Depending on your computer operating system, the device appears as either a portable device, a removable
drive, or a removable volume.

On your computer, open the file browser.

Select a file.

Select Edit > Copy.

Browse to a folder on the device.

NOTE: For a removable drive or volume, you should not place files in the Garmin folder.
6 Select Edit > Paste.

a b WN

Disconnecting the USB Cable

If your device is connected to your computer as a removable drive or volume, you must safely disconnect your
device from your computer to avoid data loss. If your device is connected to your Windows computer as a
portable device, it is not necessary to safely disconnect the device.

1 Complete an action:

+ For Windows computers, select the Safely Remove Hardware icon in the system tray, and select your
device.

« For Apple® computers, select the device, and select File > Eject.
2 Disconnect the cable from your computer.

Viewing GPS Signal Status

Hold ,yall for three seconds.

Purchasing Additional Maps

1 Go to your device product page at garmin.com.
2 Click the Maps tab.
3 Follow the on-screen instructions.

Purchasing Accessories
+ Optional accessories are available at garmin.com or from your Garmin dealer.

European Emission Standards
The European Emission Standards are standards for exhaust emissions that limit the amount of air pollutants
that are released from new vehicles sold in Europe.

You can find your vehicle's emission standards in your vehicle's owner's manual, your vehicle registration
documents, or printed on your vehicle's door frame. If you are unable to locate the emission standard for your
vehicle, you can contact your vehicle dealer or manufacturer for more information.

Garmin PowerSwitch

Garmin strongly recommends having an experienced installer with the proper knowledge of electrical systems
install the device. Incorrectly wiring the power cable can result in damage to the vehicle or the battery and can

cause bodily injury.

You can use a connected Garmin PowerSwitch device to control lights, fans, and more from your Garmin device.
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Mounting Considerations

+ The device must be mounted close to the battery and within the range of the supplied power cable.
+ The mounting surface must be strong enough to support the weight of the device.

+ The location must allow room for the routing and connection of all cables.

Mounting the Device
Before you can mount the device, you must select a mounting location and purchase the appropriate hardware
for your mounting surface.

NOTICE

Avoid wires, gauges, air bags, air bag covers, HVAC, and other items when drilling pilot holes and attaching the
mount to the vehicle. Garmin is not responsible for any damages or consequences arising from the installation.

1 Place the mount on the selected location.

N

Using the mount as a template, mark the two screw locations Q.

Drill pilot holes (optional).

For some types of mounting material, drilling pilot holes is necessary. Do not drill through the mount.
4 Securely fasten the mount to the surface using the appropriate hardware for your mounting surface.

w
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Opening the Front Cover
You must open the front cover to make electrical connections.
1 Lift the front cover latch (1) and rotate it counter-clockwise.

2 Pull the front cover off of the device.

62 Appendix



Connecting Accessories

NOTICE

Do not use the device to control or power a winch. Failure to follow this notice could cause damage to your
vehicle or your device.

Do not connect a power source to an accessory output terminal. Failure to follow this notice could cause
damage to your vehicle or your device.

Accessory requirements:

+ Verify the amperage rating of each accessory before wiring it to the Garmin PowerSwitch device. The device
supports accessories up to 30 A for each channel and a maximum of 100 A for the entire system.

+ Use 10 AWG (6 mm?) wires for accessories that use 20 to 30 A.

+ Use 12 AWG (4 mm?) wires for accessories that use 10 to 20 A.

+ Use 14 AWG (2.5 mm?) wires for accessories that use less than 10 A.
+ Use the appropriate size terminals for all accessory connections.

+ Crimp all terminal connectors securely.

1 Connect the positive wire from the accessory (1) to one of the accessory terminals (2) on the Garmin
PowerSwitch device.

IE .
o ;@'; :Oz.

/77
@
2 Connect the negative or ground wire 3) to an unpainted ground stud @) on the vehicle frame, to a ground
distribution block, or directly to the negative terminal on the battery.

/\ CAUTION
Do not connect the accessory ground wires to the ground terminal (GND) on the Garmin PowerSwitch device, as
doing so could result in personal injury or property damage, or could negatively impact device functionality.

3 Verify that all electrical connections are tight and will not come loose during use.

Connecting a Control Input

You can connect to the control terminals to enable the Garmin PowerSwitch device to turn on customizable
outputs. For example, you can connect your vehicle ignition switch to a control input terminal to turn on
accessories automatically each time you start your vehicle. The control terminals detect a signal from 3.3 V to
18 V. You can configure output functions with the Garmin PowerSwitch app.

Connect the control wire from the control source in your vehicle to one of the two control terminals on the
Garmin PowerSwitch device.
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Connecting the Device to Vehicle Power

Before you can connect the device to vehicle power, you must remove the warning tag from the +12V terminal
on the device.

You should always confirm all electrical connections are secure and will not come loose while operating the
device.

1 Connect the large ring end of the included ground wire () to the negative terminal on the vehicle battery.

2 Connect the small ring end of the ground wire to the GND terminal ) on the device.

3 Connect the small ring end of the included 12V cable to the +12V terminal (® on the device.

4 Tighten the 3/g in. nut on the +12V terminal to a maximum torque specification of 4.52 N-m (40 Ibf-in.).
You should confirm the nut cannot be loosened by hand.

NOTICE
Do not overtighten the +12V terminal to prevent damage to the terminal.

5 Connect the large ring end of the 12V cable @) to the positive terminal on the vehicle battery.

Pairing with a Garmin Navigation Device
You can pair your Garmin PowerSwitch device with a compatible Garmin navigation device.

1 Turn on power to your Garmin PowerSwitch device, and place your compatible Garmin navigation device
within 1 m (3.3 ft.) of it.

2 Onyour compatible navigation device, open the Garmin PowerSwitch app.
3 Follow the on-screen instructions to complete the pairing and setup process.

The main app dashboard appears. After the devices are paired, they connect automatically when they are turned
on and within range.
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Garmin PowerSwitch Specifications

Dimensions (D x W x H) 75x125x32mm (2.95x4.92x 1.26 in.)

Operating temperature range From -25° to 85°C (from -13° to 185°F)

Wireless frequency 2.4 GHz @ 13 dBm

Power input From 12 to 16 V using the included vehicle power cable.
Maximum accessory output 30A

Maximum system output 100 A

Current draw with all outputs off 3 mA

Water rating IEC 60529 IPX7?

Troubleshooting

My Garmin PowerSwitch will not stay connected

Verify the Garmin PowerSwitch device is receiving power.

Verify that Bluetooth technology is enabled on your paired navigation device or smartphone.
Move the navigation device or smartphone closer to your Garmin PowerSwitch device.
Verify that your vehicle's battery is supplying at least 12 V of power.

The Garmin PowerSwitch device turns off all outputs automatically to preserve your vehicle's battery if it is
receiving less than 11 V of power (My accessories are not receiving power, page 65).

My accessories are not receiving power

Verify the Garmin PowerSwitch device is receiving power from the vehicle battery.
Verify that your vehicle's battery is supplying at least 12 V of power.

The Garmin PowerSwitch device turns off all outputs automatically to preserve your vehicle's battery if it is
receiving less than 11 V of power. Outputs turn back on when the device detects more than 12 V of power.

Verify that all electrical connections are secure and will not come loose while operating the vehicle.
Verify that each connected accessory draws less than 30 A.

If an accessory draws more than 30 A, the device turns off that output automatically.

Verify that the total system load is less than 100 A.

If the device detects a system load of more than 100 A, it turns off all outputs automatically.
Inspect all electrical connections for an electrical short circuit.

1 The device withstands incidental exposure to water of up to 1 m for up to 30 min. For more information, go to www.garmin.com/waterrating.
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